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CHAPTER 1

Introduction
Welcome to the Flare Getting Started Tutorial. This tutorial shows you how to use MadCap Flare's
basic features. During this tutorial, you will create a project about San Diego, add elements to it, and
then build PDF and HTML5 outputs from it.
This chapter discusses the following:
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Using the Getting Started Tutorial
The Getting Started Tutorial is designed in a self-guided format. You can go through the tutorial at
your own pace and complete as much or as little of the tutorial as you want.
The Getting Started Tutorial covers the following:
1. Starting Projects How to build a new project from a template. See "Starting Projects" on page
8.
2. Adding Elements to Projects How to add content to your projects, such as topics, images,
cross-references, and snippets. See "Adding Elements to a Project" on page 16.
3. Making It Look Good How to use styles to make your project look the way you want it to. See
"Making It Look Good" on page 46.
4. Developing Targets How to prepare your output using conditions, PDF and HTML5 outputs,
skins, and tables of contents. See "Developing Targets" on page 53.
5. Building Output How to build the final printed and web outputs for your project. See "Building
Output" on page 78.

Using the San Diego Project Template
While you follow the steps in the Getting Started Tutorial, you will also use Flare's San Diego template to create a project about San Diego. This template was designed to be used alongside the
tutorial and will give you hands-on experience in Flare. As such, some settings and content are not
enabled when you first open the template. By following the steps in the self-paced tutorial, you can
add the rest of the content to the template, and even use the template for other projects.
You might want to take some time to familiarize yourself with the topics that have already been created for the San Diego template. You can find these in the Content Explorer on the left side of the
interface. If you want, you can also select the Project ribbon at the top of the interface and click the
Build Primary button to generate output from the template right away. This gives you an idea of how
one type of output might look.
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For More Information
There is much more to learn outside of the features covered in this tutorial. Additionally, while this
tutorial covers the recommended or most efficient way to perform a task, there are usually several
other methods that you can use. Take some time to explore Flare on your own and find the technique that is most comfortable for you. Refer to the Flare online Help for more information about
any of the features covered in this tutorial.
For new users, we also recommend the following:
n

Getting Started Guide This short PDF guide explains how Flare works and introduces you to
some of its key features and concepts. It then outlines the five basic steps for developing a
project and producing output. To download the PDF, see the online Help.

n

Getting Started Video This brief movie shows you how to start a new Flare project and gives
you insight into what you should do once that is accomplished. You can view this movie from
the madcapsoftware.com website.

Ready to Begin?
To get started using the San Diego template, see "Starting Projects" on page 8.
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CHAPTER 2

Starting Projects
Begin by creating a new Flare project and taking a tour of the workspace.
This chapter discusses the following:
Creating a Project from a Template
Flare's User Interface
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Creating a Project from a Template
A template is a Flare project that already contains a few basic topics, styles, and outputs to help you
start writing quickly. After your new project is loaded, you can make any changes as necessary.

CREATE A NEW PROJECT FROM A TEMPLATE
1. When you first open Flare, you will see the Start Page in the middle of the interface. On the
Start Page, click New Project. The Start New Project Wizard opens. This is where you can specify basic settings for your project.

2. In the Project name field, name your project San Diego.
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3. (Optional) In the Project folder field, you can enter a location where you want to save your project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.
The next screen in the wizard allows you to select the kind of project you want to create: a
template, a new project based on an existing project, or an imported project. We are going to
create a project using an existing template.
5. Under Factory Templates, expand the Tutorials folder. Select the San Diego template.
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6. Click Next.
The next screen in the wizard allows you to select the primary target or for your project. A target is a single instance of an output type, such as a PDF document or an HTML5 online Help
system. The primary target will generate by default when you build output from Flare.

7. We only have one target set up right now (we'll add more later), so go ahead and click Finish.
The San Diego project is created and loaded into Flare.

MORE INFORMATION
For more information about using this wizard, see the online Help.
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Flare's User Interface
Before we start opening files and adding content to them, let's take a minute to look at the main
areas of the workspace that you will use during this tutorial.

CONTENT EXPLORER
The Content Explorer appears on the left side of your screen, and is where you can find all of your
content-related files. Topics appear in the main content folder. You can also create subfolders to
organize your content. By default, the Resources folder is used to organize all of your content
resources (e.g., images, snippets, multimedia, stylesheets).
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PROJECT ORGANIZER
The Project Organizer is also found on the left side of your screen, in the same area as the Content
Explorer. You can click the accordion tab at the bottom to switch between the Content Explorer and
Project Organizer. This is where you can find all of your project-related files, such as targets, tables
of contents, and skins. Each of these types of files appears in its own folder.
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START PAGE
When you first open Flare, you will see the Start Page. Although you won't spend much time on the
Start Page, it is important because you can use it to create a new project, open an existing project,
and access various resources. Also, if you need to stop this tutorial and come back to it later, you
can re-open the San Diego project file from the Start Page's Recent Projects list.
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XML EDITOR
The XML Editor is located in the middle of the Flare interface. It is the primary editor that you will
use in Flare. It is used for writing, editing, and formatting content files. So once you open a topic,
snippet, or master page, it will be seen within the XML Editor.

MORE INFORMATION
For more information about the Flare interface, see the online Help.
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CHAPTER 3

Adding Elements to a Project
Now that you have created a project, it is time to add content to it. Adding content gives your project some substance. You can add a variety of different elements to a project.
This chapter discusses the following:
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Creating Topics
Even though the San Diego project has a few topics already created for you, we will start by adding a
brand new topic.

CREATE A TOPIC
1. In the Content Explorer, right-click the Content folder. From the context menu, select New >
Topic. The Add File dialog opens.
NOTE: There are several other methods that you can use to create a new topic.
However, right-clicking in the Content Explorer is the most efficient method because
you can select the folder where you want the new topic to be stored.
2. In the Add File dialog, you can select the kind of topic you want to create. In the Source area,
make sure that New from template is selected, then select NewTopic.htm from the list of factory templates. This will create a new, empty topic.
3. In the File Name field, name the topic Famous-San-Diegans.
NOTE: You don't have to use hyphens when typing a file name, like we did here. You
can run the words together or use underscores if you want, but hyphens are recommended.

CHAPTER 3

17

4. In the 1st Heading field, enter the heading Famous San Diegans. If you leave this field
blank, the topic will automatically use the file name for the heading. We will leave the rest of
the fields blank for now; the default settings are okay for these fields.
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5. Click Add. Your new topic appears in the Content folder. It also opens automatically in the
XML Editor.
After closing the topic, you can re-open it later by double-clicking the file name in the Content
Explorer.

We don't want to leave this topic empty, so let's add a little bit of text to it. We will add the
names of three famous San Diegans.
6. Highlight the placeholder text and type Some famous people from San Diego are:
and press Enter.
7. Type Cameron Diaz and press Enter.
8. Type Tony Gwynn and press Enter.
9. Type Sally Ride.
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10. Let's create a bulleted list. Highlight the names of these three famous San Diegans, then
select the Home ribbon at the top of Flare. In the Paragraph section, click
graphs are converted to a bulleted list.

11. Click
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TIP: Notice the left side of the topic. The side structure bars show each element's tag. You
may recognize these tags if you are familiar with XML or HTML. In this topic, we have an
<h1> tag (heading 1), a <p> tag (paragraph text), a <ul> tag (unordered list), and <li> tags
(list items).
While you don't need to know code to use Flare, you can use the structure bars to perform a
variety of tasks, including rearranging the items in the topic. After clicking one of these bars
and dragging up or down, you will see a blue arrow if you can drop an item somewhere else
in the topic. If you want, click a list item <li> tag and try dragging it up or down in the bulleted
list.
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If you are comfortable with XML and HTML, you can click the Text Editor tab at the bottom
of the topic. The Internal Text Editor lets you make manual changes to the markup.

MORE INFORMATION
For more information about topics, see the online Help.
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Inserting Images
Let's add an image to a topic to give it a little pizazz. There are already several images saved in this
project. By default, images are saved in the Resources folder, in the Images subfolder.

INSERT AN IMAGE
1. In the Content Explorer, double-click Food.htm. The topic opens in the XML Editor.
2. Place your cursor at the end of the paragraph about Mexican food (right after "United
States."). Then press Enter. This creates a new line for you to either type a new paragraph or
insert other content.
3. At the top of Flare, select the Insert ribbon. In the Multimedia section, select Image. The
Insert Image dialog opens.
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4. In the Select File section, navigate to Content > Resources > Images > Tacos.png.

NOTE: In this case, the image is already in our project, so you can navigate directly to
it. However, if you need to insert an image that is not in the project yet, click
to
find the image on your computer or network.
5. Click OK. An image of some tacos appears in the project.
6. Click

to save your work.

TIP: You can also drag and drop image files from the Content Explorer directly into your
topic.

MORE INFORMATION
For more information about images, see the online Help.
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Inserting Cross-References
It is fairly common to link to other topics in a project. One way to link between topics is a cross-reference. You may have noticed some cross-references in this tutorial already.
A benefit of using a cross-reference over a standard hyperlink is that cross-references use format
commands to update the link automatically. Format commands allow you to tell the cross-reference to provide page number information, the title of the topic, or even a file path.

NOTE: In this project and in the San Diego template, the default cross-reference style
(MadCap:xref) creates context-sensitive cross-references. In web-based output, these
cross-references look like a regular link. In print-based output, the text in the link is based on
the relationship of the cross-reference and the target location (e.g., see "Topic" on page 26;
see "Topic" on the next page).

We are going to add two cross-references to our project using two different methods—the standard
method and the drag-and-drop method.
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INSERT CROSS-REFERENCES USING THE STANDARD METHOD
1. In the Content Explorer, double-click San-Diego-Cuisine.htm. The topic opens in the
XML Editor.
2. At the end of the paragraph, type See . (Be sure to leave a space after See and then type a
period.)
3. Move your cursor back, and click just in front of the final period.
4. Select the Insert ribbon. In the Links section, select Cross-Reference. The Insert Cross-Reference dialog opens.
5. In the Link to: section, make sure Topic in Project is selected from the drop-down.
6. In the area below, you can select the topic to which you want to create a cross-reference.
Select Food.htm.
7. At the bottom of the dialog is the Cross-Reference Properties section. On the left side of this
section you can select the cross-reference style you want to use. You can also create a new
style or edit an existing one. The right side shows you the format command and a preview of
how the cross-reference appears in Flare.
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Scroll to the bottom of the XRef Class field and notice the style called "MadCap:xref." This is
the default cross-reference style and will be used by default when you insert a new cross-reference.

8. Click OK. Flare creates a cross-reference to Food.htm using the MadCap:xref style.
9. Click
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INSERT CROSS-REFERENCES USING THE DRAG-AND-DROP METHOD
Another common way to insert cross-references is using drag-and-drop. This method automatically
uses the main MadCap:xref style, so if you don't need to choose a different style, this is a good way
to insert a cross-reference.
1. The San-Diego-Cuisine.htm topic file should still be open in the XML Editor. We're going to add
some text and another cross-reference after the "Food" cross-reference you already added.
Your cursor should be placed between the cross-reference (the word "Food" and the period).
You want it to display as a left bracket.
Like this:

Not like this:

If necessary, you can press the right arrow twice on your keyboard to change a right bracket
to a left bracket.
Facing the bracket away from the cross-reference ensures that the new content you type will
not become part of the link.
2. Once your cursor is facing the correct way, type and . (Be sure to leave a space before and
after and.)
3. In the Content Explorer, select Beer.htm and drag it after the word and (just before the
period) in the XML Editor.
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4. A red line appears when you can drop the topic. When the line is in the correct location,
release the mouse button. Flare creates a cross-reference to Beer.htm using the
MadCap:xref style.

5. Click

to save your work.

MORE INFORMATION
For more information about cross-references, see the online Help.
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Inserting Drop-Down Text
If you have a very long topic, you may want to break up sections of it to make it easier to read. One
way to do this is to add drop-down text, which collapses sections of content under a single link in the
topic (called a "drop-down hotspot"). When users click the hotspot in the output, the text expands
and they can see the hidden content. If they click the hotspot again, the text collapses.

INSERT DROP-DOWN TEXT
1. In the Content Explorer, double-click San-Diego-Attractions.htm. The topic opens in the
XML Editor.
2. At the end of the first paragraph, press Enter to add a new line. Then type Balboa Park.
3. Use your mouse to select the three elements that relate to Balboa Park: the text you just
added, the paragraph about the park, and the image of the fountain.
4. Select the Insert ribbon. In the Text section, select Drop-Down Text.
5. Flare creates a drop-down for the content you selected. The text you added earlier (Balboa
Park) now has a special style applied to it (MadCap:dropDownHotspot) to distinguish it as a
clickable drop-down hotspot. All of the content that is included in the drop-down is surrounded
by large, light gray brackets.

Let's add drop-downs for the sections about the Zoo and Petco Park.
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6. Scroll down in the topic, and before the paragraph about the San Diego Zoo, add a new line
and type San Diego Zoo.
7. Use your mouse to select the three elements that relate to the San Diego Zoo: the text you
just added, the paragraph about the zoo, and the image of the panda.
8. Select Insert > Drop-Down Text to add a drop-down to this section.
9. Scroll down, and before the paragraph about Petco Park, add a new line and type Petco
Park.
10. Use your mouse to select the three elements that relate to Petco Park: the text you just
added, the paragraph about the ballpark, and the image of the ballpark.
11. Select Insert > Drop-Down Text to add a drop-down to this section.
12. Click
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NOTE: Drop-down effects are supported only in online outputs. You can still have them in
your topics if you plan to generate print-based outputs, such as PDF. However, it will just
look like regular text.

NOTE: If you have been following this tutorial in order, there is not an online target in the project yet. However, we'll revisit these drop-downs when we build HTML5 output. See "Creating a New Target" on page 54 and "Building HTML5 Output" on page 79.

MORE INFORMATION
For more information about drop-downs, see the online Help.
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Using Snippets
You can use snippets in your project whenever you need to reuse the same content in more than
one place, rather than rewriting or copying it. Then, when you need to make a change, you can
modify the content in the snippet and the edits will automatically appear wherever you used the snippet. You don't need to make the same change multiple times.
A snippet can be as short or long as you want. It can be just a few words, a sentence, or several paragraphs. Snippets can contain any type of content, including text, images, lists, or even other snippets.
Let's create a short snippet and place it in our project.

CREATE A SNIPPET
We will use Home.htm as the first topic that opens in our online output. There is some text in this
topic that we also want to use in the All-About-San-Diego.htm topic, which will be the first topic in
our PDF output. Let's create a snippet so we can reuse this content in both topics.
1. In the Content Explorer, double-click Home.htm. The topic opens in the XML Editor.
2. Scroll down so you can see the gray area that contains a heading, four short paragraphs, and
a list.
3. Select the first three paragraphs and the entire list (the text starting with "San Diego" and ending with "San Diegans").
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4. Select the Home ribbon. In the Snippet section, select Create Snippet. The Create Snippet dialog opens.
5. In the Snippet File field, type San-Diego-Intro. This is the name for your snippet.
6. In the Project Folder field, you can enter a location where you want to save your snippet. By
default, snippets are saved in the Content folder in the Resources > Snippets folder. This is
the recommended location for snippets, so we will not change this path.
7. In the Snippet field, use the scroll bar to review the content. You should see exactly the content you just selected (the text starting with "San Diego" and ending with "San Diegans").
NOTE: The preview won't have any styling associated with it, so it will look somewhat
plain. That's okay. The styles will show up in whatever topic the snippet is inserted
into. But if anything else looks incorrect in the preview, you can click Cancel and start
again.
8. Make sure the check box Replace Source Content with the New Snippet is selected. Since we
want to use the snippet in the current topic, this will automatically insert the snippet into that
topic for us.
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9. Click Create. Flare creates the snippet, inserts it into the topic, and adds the snippet file to the
Content Explorer. Notice that the structure bars on the left side of the content (representing
the individual paragraphs and the list) have been replaced by a single structure bar (i.e., the
snippet block), and the snippet is surrounded by light gray brackets.

10. Click
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INSERT A SNIPPET
Now that we have created a snippet, we will insert it into another topic.
1. In the Content Explorer, double-click All-About-San-Diego.htm. The topic opens in the
XML Editor.
2. Click at the end of the All About San Diego heading and press Enter to create a new empty
paragraph after it. This is where we will insert the snippet.
3. Select the Insert ribbon. In the Single Source section, select Snippet. The Insert Snippet Link
dialog opens.
4. In the Select Snippet section, navigate to Content > Resources > Snippets > San-DiegoIntro.flsnp. When you select the snippet, you will see it in the Preview section so you can confirm that you have selected the correct snippet.
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5. Click OK. The snippet appears in the topic between the main heading and the History section.

6. Click

to save your work.

TIP: You can also drag and drop snippet files from the Content Explorer directly into your
topic.

TIP: If you need to edit a snippet, you can double-click it in the Content Explorer. It will open
in the XML Editor just like a topic. However, if you end up with many snippets over time, it
might be difficult to locate the precise snippet you need. A quicker way to edit a snippet is
to right-click on a snippet that is inserted in a topic and from the context menu select Open
Link.

MORE INFORMATION
For more information about snippets, see the online Help.
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Inserting Tables
You can use tables for many purposes in Flare. We are going to insert a small table into a topic to
compare some information.

INSERT A TABLE
1. In the Content Explorer, double-click All-About-San-Diego.htm. The topic opens in the
XML Editor.
2. Scroll down to the History section of the topic. Add a new empty paragraph between the two
paragraphs in this section.
3. Select the Insert ribbon. In the Table section, select Table (the face of the button, not the
down arrow). The Insert Table dialog opens.
NOTE: If you click the down arrow below the Table button, it will open a grid that you
can use to insert a basic table. That is fine for many uses, but for this tutorial, be sure
to click the face of the button—not the arrow—so you can configure some properties
in the Insert Table dialog.
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4. In the Table Size section, use the arrows to make the following changes:
a. Set the Number of columns to 2.
b. Set the Number of rows to 4.
c. Set the Number of header rows to 1.
As you change these settings, the table in the Preview section updates to show you how your
table will appear in Flare.
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5. In the Table Style section, from the Table Style drop-down, select Basic-Alternate-Rows.css.
As you change these settings, the table in the Preview section updates to show you how your
table will appear in Flare.

6. Click OK. The empty table appears in the History section.
Let's add some data to our table.
7. Click in the top left cell of the table. This is your header row. Type Historical Affiliation.
8. Click in the top right cell of the table. Type Date.
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9. In the Historical Affiliation column, type the following:
a. In the first cell, type Spanish Empire.
b. In the second cell, type First Mexican Empire.
c. In the third cell, type United Mexican States.
d. In the fourth (bottom) cell, type United States.
10. In the Date column, type the following:
a. In the first cell, type 1769–1821.
b. In the second cell, type 1821–1823.
c. In the third cell, type 1823–1848.
d. In the fourth (bottom) cell, type 1848–present.

11. Click
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WHAT ARE TABLE STYLES?
Flare uses table styles to determine the look of a table. They are a useful way to make sure all of
your tables have a consistent look. For example, you can use a table stylesheet to determine the colors for your table's rows and columns, or for its borders. You can apply the table style to one table or
to all of the tables in your project. Table styles are handled separately from regular stylesheets.
You can also use table styles to set default styles for the cell content. In the table style we applied,
the header row is bold and centered (p.TableTextHead style class), while the rest of the rows are
left-aligned and normal weight (p.TableText style class).

MORE INFORMATION
For more information about tables and table styles, see the online Help.
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Editing Variables
Variables contain short pieces of information that appear throughout a project, like your company
name, website, and product name. You can create variables for just about anything. Variables work
sort of like snippets: you can use them throughout your project, and when you make a change to
them, the changes will appear anywhere you used the variable. This makes variables a great option
for information that might change frequently, such as dates or version numbers.
When you use the San Diego template, Flare automatically adds a few standard variables to your
project. Let's edit some of these variables so our finished project will be a little less generic.

EDIT A VARIABLE
Up to this point, we have been working with resources that are stored in the Content Explorer. Variables are a project resource, so they are located in the Project Organizer.
1. On the left side of Flare, open the Project Organizer.
2. Expand the Variables folder.
3. Double-click the General variable set. The Variable Set Editor opens to the right.
Look at the different variables in this project. There are variables for the company name,
street address (including a separate variable for the city, state, and zip code), phone number,
website, and current year. There is also a variable for the title of the PDF guide.
The name of each variable appears in the Name column. The content that will appear in the
output wherever the variable is used appears in the Definition column. Let's edit some of the
variable definitions.
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4. In the Definition column, double-click My Company, LLC. In the field, enter the name of your
company and press Enter.

5. (Optional) In the Definition column, double-click and change the definition for any other variables that you want to customize.
NOTE: You might have noticed that the Year variable has a slightly different icon,
which uses a clock
. This indicates that it is a Date/Time variable, which uses
format specifiers to represent the date or time. The Year variable uses the format
"yyyy" to represent the current year (in 4-digit format).

For more information about formatting and using Date/Time variables, see the online
Help.

6. Click

CHAPTER 3

to save your work.

44

EXAMPLE
After you finish renaming variables, you can look at them in a topic. Open the Content
Explorer, then expand the Print-Only-Topics folder. Double-click Copyright.htm.

All of the gray highlighted fields on this page are variables. Using the Show Tags
drop-down field in the local toolbar of the XML Editor, you can adjust your markers to
display inserted variables in different ways (e.g., show/hide the variable name in the
editor).
If you were to edit the variables again, and then come back to this topic, you would see
the updated information.
We will use this topic again later when we build a PDF from this project. See "Building
PDF Output" on page 82.

MORE INFORMATION
For more information about variables, see the online Help.
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CHAPTER 4

Making It Look Good
There are lots of ways in Flare to make your output look good. In this tutorial we're going to focus on
the most common way to control the look of your documentation—styles. However, keep in mind
that this tutorial only scratches the surface of how to use styles.
This chapter discusses the following:
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Applying Styles

51
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Creating Style Classes
You can use styles in your projects to format elements. While you can use local formatting (such as
selecting a single word and using the Color button on the Home ribbon to make it red), using styles
will save you time. If you edit the properties for a style in the stylesheet, that change will automatically be made anywhere you used the style class. You do not need to go back and make the
change in every topic.
After you create a new Flare project, you'll see that there are already many styles for you to use. And
you can change the properties for any of those styles to adjust the look.
In addition to using the styles that are already in place, you may find the need now and then to create your own style class. Think of a style class as a "child" of a "parent" style. A style class gives you
more flexibility when using a style. For example, you might create a red h1 (heading 1) style class
and a blue h1 style class. These would both be children of the h1 style (e.g., h1.red, h1.blue).

CREATE A STYLE CLASS
We are going to create a style class of the parent image (img) style. Then we will modify our style
class so that it turns online images into thumbnails. In other words, images will initially display very
small but when they are clicked in online output, they will be shown at the full size in a popup.
1. In the Content Explorer, open Resources > Stylesheets.
2. Double-click the Main-Styles.css stylesheet. The Stylesheet Editor opens to the right.
3. You can use the Simplified or Advanced view when editing a stylesheet. Let's use the latter. In
the local toolbar of the Stylesheet Editor, make sure the first button is labeled View:
Advanced. If it says View: Simplified, click it so that it change to the Advanced view.
4. In the upper-left corner of the editor, set the drop-down to
it easier to find the style.

to make

5. In the Styles section, select img.
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6. In the local toolbar of the editor, click

. The New Selector dialog opens.

7. In the Class Name field, type thumbnail.

8. Click OK. The thumbnail style class appears in the stylesheet, indented under the img parent
style.

The style class is added, but the only properties it has right now are the ones it has inherited
from the img style. Now we need to add unique properties to the thumbnail style class.
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9. With the new thumbnail class selected, from the Show field in the upper-right corner of the
editor, select
. This will display only the properties that are
related to images, making it a lot easier to find the properties that you need to set.

10. Make sure the properties on the right side of the editor are shown in group view, which means
there will be different categories that you can expand and collapse. In the local toolbar, you
should see a Grouped View button
. If instead you see the Alphabetical View button
,
click it to switch to Group View.

11. Expand the Thumbnail group.
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12. Next to the mc-thumbnail property, click
nail settings as they are.

13. Click

and select popup. We will leave the other thumb-

to save your work.

MORE INFORMATION
For more information about styles and creating classes, see the online Help.
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Applying Styles
Now that we have created the thumbnail style, we can apply it to an image.

APPLY A STYLE
1. In the Content Explorer, double-click San-Diego-Attractions.htm. The topic opens in the
XML Editor.
2. Select the Home ribbon. In the Styles section, select Style Window. The Styles window pane
opens on the right side of the Flare interface.
The Styles window pane displays formatting options for the text that is currently selected. For
example, if you have clicked in a paragraph, you will see several styles for formatting text,
such as heading styles and any children of the parent p style.
3. In the XML Editor, select the image of the fountain. In the Available Styles section of the
Styles window pane, the style that is currently applied to the image of the fountain (i.e., the
img style) is shown at the top and highlighted in the list below.
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4. In the Styles window pane, click img.thumbnail. In the XML Editor, the image of the fountain
shrinks to the dimensions for the thumbnail (as specified in the stylesheet).

5. Apply the img.thumbnail style to the image of the panda and the image of Petco Park.
6. Click

to save your work.

NOTE: If you want, you can apply the img.thumbnail style to other images in the San
Diego project.

MORE INFORMATION
For more information about applying styles, see the online Help.
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CHAPTER 5

Developing Targets
After your project is styled, you are ready to start preparing your output files. You can set up different output types (e.g., PDF, HTML5, EPUB) and define settings that tell Flare what information to
include in the final documents.
This chapter discusses the following:
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Creating a New Target
When you want to produce a new kind of output, you need to add a target to your project. A target is
a single instance of an output type, such as a PDF, an online Help system, an eBook, or a Word document. You can create as many targets as you need to.
Right now, the San Diego project is set up so you can build a single PDF target. However, we also
want to create an online target. The type of online output we recommend is HTML5.

CREATE A NEW HTML5 TARGET
1. In the Project Organizer, right-click the Targets folder. From the context menu select Add Target. The Add File dialog opens.
2. In the Add File dialog, you can select the kind of target you want to create. In the Source area,
make sure that New from template is selected, then select MyTarget from the list of factory
templates (this should be selected by default). This will create a new target with default settings selected.
3. From the Output Type drop-down, select HTML5.
4. In the File Name field, enter All-About-San-Diego-HTML5.

5. Click Add. The new target is added to the Targets folder in the Project Organizer.
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SET THE STARTUP TOPIC FOR A TARGET
We will use a special topic (Home.htm) for the landing page in our online target.
1. The editor for your new target should already be open. But in case it isn't, double-click the AllAbout-San-Diego-HTML5 target in the Project Organizer.
2. In the Target Editor, select the General tab.
3. Next to the Startup Topic field, click

. The Select File dialog opens.

4. In the list of topics, select Home.htm.
5. Click Open. Home.htm is now associated as your target's startup topic.

6. Click

to save your work.

NOTE: The home page we are using for our HTML5 startup topic uses its own stylesheet
and master page (these things are already set up for you). This is why it has a different look
and feel than the other pages. If you want to learn more about how to configure the settings
for HTML5 output, refer to the Top Navigation Tutorial in the online Help.

MORE INFORMATION
For more information about targets, see the online Help.
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Using Conditions
The San Diego project has condition tags set up for printed and online output. In this lesson we will
apply these conditions to a couple of paragraphs.

APPLY CONDITION TAGS
1. In the Content Explorer, double-click All-About-San-Diego.htm. The topic opens in the
XML Editor.
2. Right-click the snippet under the heading that you inserted previously. In the context menu,
click Open Link.

The snippet opens in a new tab.
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3. Right-click the p structure bar to the left of the paragraph that begins “In this PDF guide…”

4. From the context menu, select Conditions.
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The Condition Tags dialog opens. In this dialog, you can see the Default condition tag set.
There are two conditions in the set: PrintOnly and ScreenOnly.

NOTE: In your own project, you can create as many condition tag sets and conditions
as you need. And you don't need to use the ones provided in the Default condition tag
set. They're simply a starting point for you.
5. Since we want this heading to appear in our PDF, select the check box next to PrintOnly.
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6. Click OK.
If you have markers turned on (by clicking the down arrow next to
and selecting Show Markers), the entire paragraph is highlighted red.

in the local toolbar

NOTE: If you still do not see the red highlight, you may need to turn your conditional
indicators on. To do this, click

7. Click

in the bottom toolbar of the XML Editor.

to save your work.

Now we will apply the other condition tag to the next paragraph. But this time we're going to
do it a little differently. Conditions can also be associated with styles, so we're going to use
that method.
8. In the Content Explorer, navigate to Resources > Stylesheets and double-click MainStyles.css. The Stylesheet Editor opens.
9. In the local toolbar, click Add Selector. The New Selector dialog opens.
10. Previously in this tutorial, we created a class of the parent img style (see "Creating Style
Classes" on page 47). But now we're going to create something called a "generic style class."
This class will not be directly associated with any parent style, which means that any parent
style can use it. In the HTML Element field, clear any text in it.
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11. In the Class Name field, type OnlineOnly.

12. Click OK.
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13. In the Stylesheet Editor, click in the drop-down in the upper-left corner and select All Styles.

14. In the list of styles below, expand (Generic Classes).
15. Select OnlineOnly, the class you just created.
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16. In the Show drop-down field in the upper-right corner, select Show: All Properties.

17. Expand the Unclassified group below.
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18. Scroll down until you find the mc-conditions property and click

to the right of it.

The Condition Tags dialog opens.
19. Since our new generic style class is intended for online content only, select the check box
next to ScreenOnly.
20. Click OK.
21. Click

to save your work.

22. Now we will apply that new generic style class to one of the paragraphs in our snippet. Go
back to the San-Diego-Intro.flsnp snippet.
23. Right-click the p structure bar just to the left of the sentence that begins with “This website…”
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24. In the context menu, select Style Class and then choose .OnlineOnly.
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If you have markers turned on, the entire paragraph is highlighted blue.

This second method might seem like a lot of steps, but remember, creating the style class
and associating a condition with it is a one-time setup. Once that is done, you can apply the
generic style class to any parent tag (e.g., p, ol, img) that you want to be shown only in online
output. And that's a very quick task.
25. Click
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ASSOCIATE CONDITION TAGS WITH A TARGET
You have applied condition tags to content, but they won't do anything if you don't also associate
them with the targets you are going to build. Associating the condition tags with a target tells Flare
which conditions to include or exclude when building the output.
We have already associated conditions with the PDF target for you. But you still need to associate
conditions with your new HTML5 target.
1. In the Project Organizer, expand the Targets folder.
2. Double-click the All-About-San-Diego-HTML5 target. The Target Editor opens to the right.
3. Select the Conditional Text tab. This tab allows you to select which conditions will be included
and which will be excluded from the output.
4. Next to the Default.PrintOnly condition, select the Exclude check box. We do not want to see
content marked with the print condition in the HTML5 target.
5. Next to the Default.ScreenOnly condition, select the Include check box. We do want to see
content marked with the screen condition in the HTML5 target.

6. Click

to save your work.

MORE INFORMATION
For more information about conditions, see the online Help.
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Working with Skins
When you are using an online output, you will want to give some structure and style to the page.
Skins are a pre-designed look and feel for the container displaying the final output. They let you set
the logo, colors, fonts, and more for the area that surrounds the main topic content.
We could have discussed skins earlier in "Making It Look Good" on page 46, but skins need to be
linked to an online target and we hadn't created our HTML5 target yet. So we'll take a look at skins
now.

NOTE: You will find that many of the tasks in this tutorial don't necessarily have to be done
in a precise order. For example, there might be times when you are near the end of your project, preparing to generate the final output (the final step in the overall process), but you
decide to add a few new elements and some content (step 2 in the overall process) before
doing so.

SET A LOGO IN THE SKIN
There are many things you can do to give your skin its own style. One of the first things you will probably do when setting up a skin is put your company or product logo in your skin. Let's put a logo in
our skin.
1. In the Project Organizer, expand the Skins folder.
2. Double-click the HTML5 -Top-Navigation skin. The HTML5 Skin Editor opens to the right.
3. Select the Styles tab. The skin styles are on the left side and a dynamic preview area is shown
on the right side. By dynamic, we mean that you can actually click in the preview area and navigate to different parts of the skin.
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Also notice the three mediums at the top of the editor (Web, Tablet, and Mobile). These let
you provide different style settings for the skin, depending on the size of the device. In this
tutorial, we're only going to concern ourselves with the Web medium, so we'll keep it selected.

You should be able to see the default logo in the preview area.
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4. The Logo group is pretty easy to spot on the left side of the editor. But sometimes it can be a
bit more difficult to find the style you need to change. So here's a little trick. In the local toolbar of the editor, click Highlight.

5. This button synchronizes the styles on the left with whatever you click in the preview area.
Let's try it. In the preview, click the logo.
The Logo group on the left is selected and expanded. Now you know the general area where
you need to make your changes.
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6. Under the Logo section, expand the Background section.

7. Next to the Image field, click
8. In the dialog, click

. The Insert Image dialog opens.

.

9. In the Open File dialog, navigate to...\Documents\MyProjects\San Diego\Content\Resources\Images. Then select San-Diego-Logo-Transparent.png.
NOTE: This is the location for the logo if you used the project settings in "Creating a
Project from a Template" on page 9. Otherwise, you can locate the logo in the location where you saved the San Diego project file.
10. Click Open.

CHAPTER 5

70

11. Click OK. The logo appears in your skin. You can see the preview of how the logo will look in
the final output on the right side of the HTML5 Skin Editor.

12. Click

to save your work.

NOTE: In this project, a logo also appears in the Home-Page.flmsp master page, which controls the look of the home page. This logo has already been set up for you, but if you want to
view it or change it, you can open the master page in your Flare project by navigating to Content > Resources > MasterPages > Home-Page.flmsp.

CHAPTER 5

71

ASSIGN A SKIN TO A TARGET
Now that we've created the skin, we can assign it to the HTML5 target we created.
1. In the Project Organizer, expand the Targets folder.
2. Double-click the All-About-San-Diego-HTML5 target. The Target Editor opens to the right.
3. Select the Skin tab.
4. In the Skin field, select HTML5 -Top-Navigation.

5. Click

to save your work.

MORE INFORMATION
For more information about skins, see the online Help.
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Using a Table of Contents
Let's create a table of contents (TOC) to organize the topics that will go into our targets.
But as you do this, keep something very important in mind. A TOC file in online output acts as your
online navigation. But for print-based outputs, a TOC file acts more like an outline; it's simply used to
tell Flare which topics should be included in the print output and in what order. The actual generated
TOC in print-based outputs is done a bit differently. It uses something called a "TOC Proxy." See the
online Help for more information.
In the San Diego template, there are two TOC files already created for you—one for printed output
and one for online output. Since we added a topic to this project earlier (Famous-San-Diegans.htm;
see "Creating Topics" on page 17), we need to add that topic to these TOCs before we can build our
outputs.

ADD A TOPIC TO THE ONLINE TOC
1. In the Project Organizer, expand the TOCs folder.
2. Double-click Online-TOC. The TOC Editor opens to the right.
3. Open the Content Explorer.
4. In the Content Explorer, select Famous-San-Diegans.htm and drag it to the TOC Editor on the
right. You will see a blue arrow when you can drop it. Drop the topic under San Diego Cuisine.
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If you click elsewhere in the TOC, you’ll see that your new TOC entry is blue, like the others.
This doesn’t mean that the text will show up as blue in the output. Instead, what it means is
that the TOC entry contains a system variable. This variable is called “LinkedTitle.” It means
that the TOC entry text is tied to the title for that topic. If the title for the topic changes, the
TOC entry will automatically change too so that you don’t have to remember to do it manually.
See the online Help for more information.

NOTE: You don’t need to use system variables for your TOC entries. Instead, you can
override a system variable by simply typing whatever text you want in place of the
blue variable text. If you do that, the text will display as black in the TOC Editor.

NOTE: This topic should appear under San Diego Cuisine, but not on the same level
as Food and Beer. If Famous San Diegans drops on the same level as Food and Beer,
use the blue arrow
in the local toolbar of the TOC Editor to move it to the same
level as San Diego Cuisine.

5. Click
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ADD A TOPIC TO THE PRINT TOC
Adding a topic to the Print TOC follows basically the same steps. However, there are a few additional steps because you must set printed output settings for the new topic.
1. In the Project Organizer, expand the TOCs folder.
2. Double-click Print-TOC. The TOC Editor opens to the right.
3. In the Content Explorer, select Famous-San-Diegans.htm and drag it to the Print TOC. You will
see a blue arrow when you can drop it. Drop the topic under San Diego Cuisine and before
References.

NOTE: Remember that the Print TOC will function as an outline, rather than a true
TOC. So even though the TOC entries are blue (linked to a system variable), this
doesn’t really matter. This TOC only determines which topics will be included in the
output, but the labels on the TOC entries will not be used in the output; they are simply
for your information.
4. In the TOC Editor, double-click Famous San Diegans. The Properties dialog opens.
NOTE: If double-clicking a TOC entry opens the topic instead of the Properties dialog,
click
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5. Select the Printed Output tab.
Famous San Diegans should be a new chapter in our PDF guide, so we will set it up to use
these settings.
6. In the Break Type field, select Chapter Break.
7. In the Page Layout field, select Chapters. This is a page layout that is included with the San
Diego template.
8. In the Page Type field, select First Right. This will automatically start the chapter on a right
page.

9. Click OK. When you build the PDF output, you will notice these settings.
10. Click

to save your work.

NOTE: There's more to preparing a project for print-based output than what we're showing
you here. How much is involved depends on how intricate you want to get with your output.
See the online Help for more information.
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ASSIGN A TOC TO A TARGET
The Print TOC file is already associated with our PDF target. But we still need to assign the Online
TOC file to our HTML5 target.
1. In the Project Organizer, expand the Targets folder.
2. Double-click the All-About-San-Diego-HTML5 target. The Target Editor opens to the right.
3. Select the General tab.
4. In the Master TOC field, select Online TOC.

5. Click

to save your work.

MORE INFORMATION
For more information about TOCs, see the online Help.
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CHAPTER 6

Building Output
After your targets are prepared, you are ready to build your final output. In this tutorial, you will build
PDF and HTML output.
NOTE: A PDF target has been created for you as part of the San Diego template. However,
if you want to build HTML5 output, you must first follow the tutorial steps to create an
HTML5 target. See "Creating a New Target" on page 54.
This chapter discusses the following:
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Building HTML5 Output
When you have finished adding all of your content to the project and made sure all of the styles and
target settings are set, you are ready to build your final output.

BUILD HTML5 OUTPUT
1. In the Project Organizer, expand the Targets folder.
2. Double-click the All-About-San-Diego-HTML5 target.
. The Builds window pane opens at the
3. In the local toolbar of the Target Editor, click
bottom of the Flare interface, and the target begins to build.

NOTE: The Builds window pane opens automatically when you generate a target. You can
monitor the progress of the target's build status in this pane. As the target is building, you
will see a light green progress bar in the Build Progress column. When the build completes
successfully, the progress bar turns dark green. If an error prevents the build from finishing,
the bar turns red and the build stops.

For more in-depth information about the information in the Builds window pane, please see
the online Help.

NOTE: There are several other ways to build a target, including from the Builds window
pane and from the Project ribbon.
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VIEW HTML5 OUTPUT
After you have built your output, you can view it. In the Builds window pane, you can double-click the
row. Alternatively, in local toolbar of the Target Editor, you can click
opens in your default web browser.

. The HTML5 output

TIP: You can set Flare to open output automatically when the build is finished. To do this,
select File > Options. In the Options dialog, select the Build tab, then select the check box
next to View output after successful build.

NOTE: If you build output while using a trial version of Flare, you will see jumbled characters
in your output. After you become a licensed user, you will be able to build output normally.
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REVIEW THE SAN DIEGO PROJECT IN HTML5 OUTPUT
We have made many changes to the San Diego project. Here is a list of things you might want to
look at in the HTML5 output. When you build your PDF output (see "Building PDF Output" on the next
page), compare the two and see how these items differ.
n

Home Page Look at the startup topic. Notice how it has a different look and feel from the rest
of the topics. That's because it is using a different stylesheet and master page.

n

Snippets and Condition Tags Open the All About San Diego topic, and notice the content at
the top that is contained in a snippet. It looks just like the rest of the content in the topic. Also
notice that the condition was applied correctly in the snippet so that the paragraph mentioning a website displays, but not the paragraph talking about PDF output. You can open the
Home page to see the same snippet.

n

Cross-References Test the cross-reference links in the San Diego Cuisine topic.

n

Drop-Down Text and Images In the San Diego Attractions topic, test the drop-down text. Also
click the thumbnail images.

n

Skins Look at the top of the topics and see the logo that you added.

n

Table of Contents Notice the way the navigation works in HTML5 output and how it differs
from the table of contents in PDF output. In HTML5 Top Navigation output such as this, the
TOC is converted to menus; you can also add context-sensitive side menus (use one of the
Top Navigation project templates when creating a project to see this in action). In Tripane outputs, the navigation will look more like a traditional TOC in an online Help system.

MORE INFORMATION
For more information about building output and HTML5 targets, see the online Help.
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Building PDF Output
Now let's build the PDF output.

BUILD PDF OUTPUT
1. In the Project Organizer, expand the Targets folder.
2. Double-click the All-About-San-Diego-PDF target.
. The Builds window pane opens at the
3. In the local toolbar of the Target Editor, click
bottom of the Flare interface, and the target begins to build.

VIEW PDF OUTPUT
After you have built your output, you can view it. In the Builds window pane, you can double-click the
row. Alternatively, in local toolbar of the Target Editor, you can click
your default PDF viewer.
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REVIEW THE SAN DIEGO PROJECT IN PDF OUTPUT
Here is a list of things you might want to look at in the PDF output. When you build your HTML5 output (see "Building HTML5 Output" on page 79), compare the two and see how these items differ.
n

Snippets and Condition Tags Open the All About San Diego chapter, and notice the content at
the top that is contained in a snippet. It looks just like the rest of the content in the topic. Also
notice that the condition was applied correctly in the snippet so that the paragraph mentioning the PDF guide displays, but not the paragraph talking about a website.

n

Cross-References Look at the context-sensitive cross-references in the San Diego Cuisine
chapter.

n

Drop-Down Text and Images In the San Diego Attractions chapter, notice that the drop-down
effects display as regular text. Also notice that the images are full size, not thumbnails.

n

Table of Contents Look at the table of contents and see how it differs from the navigation in
HTML5 output. Also notice how the chapters start on right pages, leaving a blank page on the
previous left page. This includes the Famous San Diegans topic, which you set to be the start
of a new chapter.

n

Variables Look at the copyright page and the variables on it.

MORE INFORMATION
For more information about PDF targets, see the online Help.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
USER GUIDES

Accessibility Guide

HTML Help Guide

Analysis and Reports Guide

HTML5 Guide

Architecture Guide

Images Guide

Autonumbers Guide

Importing Guide

Condition Tags Guide

Index Guide

Context-sensitive Help Guide

Key Features Guide

Eclipse Help Guide

Language Support Guide

Getting Started Guide

MadCap Central Integration Guide

Global Project Linking Guide

Master Pages Guide
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Micro Content Guide

Source Control Guide: Git

Movies Guide

Source Control Guide: Perforce

Navigation Links Guide

Source Control Guide: Subversion

Plug-In API Guide

Source Control Guide: Team Foundation Server

Print-based Output Guide

Styles Guide

Project Creation Guide

Tables Guide

Pulse Guide

Tables of Contents Guide

QR Codes Guide

Targets Guide

Reports Guide

Templates Guide

Reviews & Contributions Guide

Topics Guide

Search Guide

Touring the Workspace Guide

SharePoint Guide

Transition From FrameMaker Guide

Skins Guide

Variables Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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